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Introduction

With its speed, stability, and superior graphics support, Mac OS X makes an ideal platform
for creative professionals. But perhaps you’ve been unsure about how to make a smooth
transition from your current Mac OS 9–based system (including your applications and
peripherals) to one that uses Mac OS X.

This document describes various Mac OS X upgrade scenarios, with step-by-step instruc-
tions for implementing them. It also offers recommendations for setting up your new 
Mac OS X system most efficiently for design and printing projects.

As you’ve probably heard, Mac OS X is easy for Mac OS 9 users to learn—and it provides
some significant benefits over that earlier operating system. Enhancements to the Finder
(such as the new column view) allow you to navigate through your files and folders faster
than ever. You can even view images, play audio tracks, and preview movies without 
having to launch an application.

The use of standard protocols for file sharing, printing, and other services in Mac OS X
enables you to collaborate more smoothly with users of Windows-based computers,
and to preserve your investment in printers and other devices. The UNIX foundation 
offers dramatic productivity benefits through such features as preemptive multitasking,
symmetric multiprocessing, multithreading, and automatic memory management. Mac 
OS X even includes a full set of developer tools at no additional charge. And the Classic
environment lets you continue to run the Mac OS 9 applications you depend on.

Read on to find out how to upgrade your existing Mac or move to a new Mac to start
enjoying the advantages of Mac OS X.
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Transition Paths

You’ll be able to transition to your new system in a few easy steps. Just follow these
recommendations and you’ll be up and running in no time.

There are two main ways you can transition to Mac OS X:

• Install Mac OS X on your existing Mac (either instead of or in addition to Mac OS 9).

• Switch to a new Mac that already has Mac OS X installed on it.

To upgrade, simply follow the instructions for the path you will be taking. These
instructions assume that you have had some experience using Mac OS 9.

Whichever path you choose, you’ll want to familiarize yourself with Mac OS X after you
install it. See the chapter “Mac OS X Basics” on page 36 and the subsequent chapters
on printing, fonts, and other common tasks for help with learning Mac OS X.

Path 1: Upgrade Your Existing Mac
Use this path if you want to install Mac OS X on an existing Mac OS 9 computer.
You can choose to keep all of your existing files (and even Mac OS 9, if you wish) on
the hard drive, or to erase the drive and perform a fresh installation of Mac OS X and
your applications. Both ways will work and are covered in the steps below.

1. Evaluate your computer and peripherals. (See “Evaluating Your Hardware,” page 8.)

2. Evaluate your applications. (See “Evaluating Your Software,” page 10.)

3. Record your current network settings. (See “Recording Your Mac OS 9 Network
Settings,” page 12.)

4. Back up your files. (See “Backing Up Your Files,” page 14.)

5. Verify that your file system is working properly. (See “Verifying Your File System,”
page 16.)

6. Prepare the Classic environment, if needed. (See “Preparing the Classic Environment,”
page 21.)

7. Determine whether your Mac needs any firmware updates. (See “Updating Firmware,”
page 22.)

8. Install Mac OS X. (See “Installing Mac OS X,” page 23.)

9. Install the Mac OS X applications you need. (See “Migrating Your Applications,”
page 26.)

10. If you performed a disk reformatting during this process, you now need to reinstall
your files. Even if you haven’t reformatted the disk, you may want to consider moving
some of your existing files to new locations, especially if you’ll be using them with 
Mac OS X applications. See the chapter “Organizing Your Files” on page 27 for helpful
information on storing your files efficiently in Mac OS X.

6Guide for Creative Professionals
Migrating to Mac OS X



Path 2: Move to a New Mac
Use this path if you will be moving your applications and files to a Mac that already
has Mac OS X.

1. Evaluate your computer and peripherals. (See “Evaluating Your Hardware,” page 8.)

2. Evaluate your applications. (See “Evaluating Your Software,” page 10.)

3. Record your current network settings. (See “Recording Your Mac OS 9 Network
Settings,” page 12.)

4. Prepare the Classic environment, if needed. (See “Preparing the Classic Environment,”
page 21.)

5. Install the Mac OS X and Mac OS 9 applications you need. (See “Migrating Your
Applications,” page 26.)

6. Decide how to best organize your files. (See “Organizing Your Files,” page 27.)

7. Copy your files from your old computer to the new one. (See “Moving Your Files to a
New Mac,” page 31.)
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Evaluating Your Hardware

Nearly all Macintosh systems sold since 2000 can run Mac OS X as long as they have
enough RAM and hard disk space. Here’s how to determine whether your computer is
ready for Mac OS X. If you’re moving to a computer that already has Mac OS X installed,
just read the sidebar “Hardware requirements for creative professionals.”

Mac OS X Hardware Requirements
The following Macintosh models can run Mac OS X:

• iMac
• eMac
• Power Mac G3
• Power Mac G4
• Power Mac G4 Cube
• Power Mac G5
• iBook
• PowerBook G3 (except the original PowerBook G3)
• PowerBook G4

(Note: Mac OS X does not work on systems that have processor upgrade cards.)

Make sure that your system also has:

• At least 128MB of physical RAM (not virtual memory)
• A built-in display, or a display connected to an Apple-supplied video card (most 

other video cards sold for Mac systems should also work with Mac OS X; check with 
the manufacturer)

• At least 2GB of disk space

Unlike Mac OS 9, new releases of Mac OS X are not hardware specific. Any Macintosh 
system that can run Mac OS X can use the current version of the operating system.

Third-Party Hardware and Peripherals
Hundreds of products from Canon, Nikon, HP, Sony, LaCie, Epson, Lexmark, 3M, Kodak,
Kensington, Logitech, and many other leading vendors are ready to work with Mac OS X
right out of the box. What external devices will you want to use with your upgraded
Macintosh computer? These are the most common ones used in design and print work:

• Printer
• Scanner
• Removable storage
• Digital camera
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Hardware requirements for creative 
professionals
In addition to the basic system requirements
for Mac OS X, you should have at least 512MB
of RAM for typical desktop publishing work.
If you do a lot of image editing or work with
large files, you’ll likely notice a performance
improvement in your applications as you add
more RAM to your system.

Storage capacity is vital for complex design
and print projects, so a minimum of 8GB of
available disk space is recommended before
you install Mac OS X.

Apple also recommends that creative pro-
fessionals have a 600MHz or faster PowerPC
G3 or G4 processor or any PowerPC G5
processor.



• Audio devices (microphone, speakers, other devices)
• Video cards
• CD burner
• PDA
• SCSI add-in cards

Mac OS X features an advanced I/O system based on established open standards so
that it can support the entire spectrum of peripherals used by design professionals.
It comes preconfigured with support for many camcorders, digital cameras, storage
devices, scanners, printers, and input devices. See Appendix B for links to up-to-date
lists of peripherals that are directly supported in Mac OS X.

Other products may require third-party drivers that have been adapted to take 
advantage of Mac OS X. Information on driver availability can be obtained directly 
from the manufacturer, or from the Apple downloads site at www.apple.com/
downloads/macosx/drivers.
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Evaluating Your Software

More than 6000 applications specifically built for Mac OS X are already available. If 
you have software that has not yet been updated, you can probably run it in the
Classic environment that’s built into Mac OS X. In fact, nearly all Mac OS 9 applications
will run properly in Classic. So with Mac OS X, you can take advantage of great new
features while maintaining compatibility with your existing applications.

This chapter helps you evaluate the software most often used by creative professionals.
You may also want to read the information at www.apple.com/macosx/applications.

Image Editing and Page Assembly Software
QuarkXPress. Adobe Photoshop, Illustrator, and InDesign. Macromedia FreeHand. These
leading creativity applications and many more are now available in native Mac OS X
versions to help you work more productively than ever. Check with the developer of
your applications to find out whether they’ve been upgraded. If not, you can almost
certainly still use them simply by double-clicking one to launch the Classic (Mac OS 9
compatibility) environment in Mac OS X.

A number of popular third-party plug-ins and extensions that add features to Adobe
Acrobat, InDesign, QuarkXPress, and other applications have already been updated to
run on Mac OS X, and others are under development. Check with the vendor for their
current status.

Font Management Software
A number of Mac OS X font managers are available, including DiamondSoft Font
Reserve, Extensis Suitcase, and Insider Software FontAgent Pro. If you have been using
Mac OS 9 versions of these applications, your transition will be easy. The Mac OS X 
versions will be familiar to you, and in some cases, the same software you’re already
running on Mac OS 9 will also run on Mac OS X. Check the system requirements on 
the software package or contact the vendor for details.

If you have been using Adobe Type Manager Deluxe to manage your fonts in Mac OS
9, you will need to switch to a different solution, because Adobe has not released a
version of ATM Deluxe for Mac OS X. Trial versions of all the font managers mentioned
above are available from their respective developers’ websites.
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Productivity Software
Mac OS X ships with a full-featured email application called Mail. It can import mail-
boxes from various email applications, including Entourage, Outlook Express, Claris
Emailer 2.0v3, Netscape 4, and Eudora, so switching to it is straightforward.

In addition, most third-party email applications have been updated to run natively in
Mac OS X, so if you prefer to keep using your current email program, it’s most likely
available in a Mac OS X version. Check the vendor’s website for details.

Microsoft Office v. X for Mac brings the new look and capabilities of Mac OS X to your
favorite Microsoft productivity applications. You can use your existing Word, Excel, and
other documents in this new version of Office.

Financial applications such as Quicken, QuickBooks, and MYOB are also available in
Mac OS X versions.

Extensions and Control Panels
One of the advantages of Mac OS X is that you no longer have to worry about system
extensions and control panels conflicting with each other, because Mac OS X doesn’t
have them. If you desire specific functionality offered by any of your old extensions,
check whether Mac OS X has the equivalent feature built in. If it doesn’t, check with
the developers of your extensions to see whether they offer similar software for 
Mac OS X.

AppleScript Scripts
AppleScript is fully supported in Mac OS X. In fact, Mac OS X v10.2 ships with dozens
of useful preinstalled script tools. Using AppleScript Studio software, you can easily
create powerful Mac OS X applications written entirely in AppleScript that have the
beautiful Mac OS X “Aqua” interface look and feel.

Some of your existing AppleScript scripts may need to be modified to work properly
on Mac OS X, so you’ll want to test them once you’ve made the transition.
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Recording Your Mac OS 9
Network Settings

If you’re planning to connect to a network or to the Internet through an ISP, you need
to configure network settings in Mac OS X. In this chapter, you’ll gather the network
configuration information from your current Mac so that you can set up networking
connections in Mac OS X.

Network information is stored in various locations in Mac OS 9 depending on the type
of network connection. When checking your settings, remember to record the settings
for all of the configurations that you use—not just the active one. In the TCP/IP and
Remote Access control panels, you can switch between configurations by choosing
Configurations from the File menu.

TCP/IP. TCP/IP settings are stored in the TCP/IP control panel. You may have multiple
configurations, so make sure to copy each one.
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PPP. The settings for PPP—which is used for dial-up connections—are located in the
Remote Access control panel. You may have multiple configurations, so make sure to
copy each one.

PPPoE. Mac OS 9 doesn’t support PPPoE (PPP Over Ethernet), so if you’re using this
connection method (such as over DSL), its settings are probably stored in a third-party
application that was provided by your ISP. Mac OS X has built-in support for PPPoE, so
you will not need a special application to use it after your transition.

An easy way to copy your settings is to make a screen shot of the window in which
they are displayed. To do this in Mac OS 9, press Command–Shift–Caps Lock–4, then
click the window you want a picture of. The picture file will appear on the top level 
of your hard disk with the name Picture 1. Repeat as needed for your other settings
windows. You can open and print the pictures using SimpleText.

If you are adding Mac OS X to your existing Mac, Setup Assistant will guide you
through the necessary network configuration the first time you start up the computer
after installing Mac OS X. If you are moving your applications and files to a Mac that
already has Mac OS X up and running, you will need to go to the Network pane in
System Preferences and enter your network information into the TCP/IP, PPPoE, and/or
AppleTalk tabs.
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Backing Up Your Files

If you plan to install Mac OS X on the same drive as your Mac OS 9 system, you 
probably don’t want to remove any existing files from the disk. Installing Mac OS X
should not affect your current files. However, it’s always a good idea to back up 
important files before making any major changes to a computer.

If you already have a backup solution in place, make a fresh backup and proceed to
the chapter “Verifying Your File System” on page 16.

File Backup Utilities
File backup utilities make it easy to back up individual files, groups of files, or the
entire contents of your hard disk. They allow you to save your files on a number of 
different types of internal, external, and removable storage devices, including hard
disks, tapes, network servers, CDs, and DVDs.

At this point in the transition process, your backup utility will have to run in Mac 
OS 9. However, in the long term you will want a backup utility that runs in Mac OS X.
A number of backup utilities can run in either version of the Mac OS; here are some 
of them:

• Dantz Retrospect or Retrospect Express
• Norton SystemWorks for Macintosh (includes Retrospect Express)
• FWB Backup ToolKit
• Tri-BACKUP from TRI-EDRE

If you prefer, you can transfer your files to another storage device manually. This
method is fine for data files, but is not recommended for backing up your operating
system. Many invisible files are used by the operating system, so copying them by
hand can be risky.

What You Should Back Up
When deciding which files are important and should be backed up for safety, consider
the following:

• Customer job files
• Fonts
• Letters and contracts
• Digital artwork
• Digital photographs and scans
• Product serial numbers and license keys
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• Email messages
• Address book information
• Checkbook data
• Invoices
• Browser bookmarks

Even if your disk is well organized, it can be easy to miss important files. If you are
worried about this, your best strategy is to back up everything on your disk—even 
if it means purchasing backup software and an external storage device.
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Verifying Your File System

To ensure that your file system is in good shape, you’ll now run Disk First Aid, a func-
tion that is built into the Disk Utility application. It’s used to verify and, if necessary,
repair the file system on your disk.

To run Disk First Aid, do the following:

1. Start up the computer from the Mac OS X Disc 1 CD. (To start the computer from a
CD, press the “c” key after you hear the startup chime, and hold it until the Apple logo
appears on the screen.)

2. From the File menu, choose Open Disk Utility.

3. Select the First Aid tab.

4. Highlight the disk volume you wish to repair from the list of disks on the left side of
the Disk Utility window. (In the list, volumes have names next to their icons; disks have
sizes.)

5. Click the Repair Disk button.

6. Once the repair is completed, scroll down to the bottom of the text box in the First
Aid pane to see the results.

7. If Disk First Aid says, “The volume [your volume name] appears to be OK,” you are 
finished and can proceed with installing Mac OS X.

If there are problems, run Disk First Aid a second time. If problems persist, read the
next section or reformat your disk as described in the chapter “Formatting Your Hard
Disk” on page 18.
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Third-Party Disk Utilities
If Disk First Aid is unable to repair your disk, you can try using a different disk utility.
Popular third-party disk utilities include:

• Alsoft DiskWarrior
• Micromat TechTool Pro
• Micromat Drive 10
• Symantec Norton Utilities

Before using any other disk utility, make sure that you have a current backup of 
your important files. Once you have created a backup, carefully follow the utility’s
instructions to perform the repair.

Final Checks
Even if you had a problem that your disk utility was able to repair, it’s wise to take
some time and browse the folders and files on your disk to make sure that everything
appears to be all right. If the repaired volume contains your Mac OS 9 system soft-
ware, verify that you can still start up your computer from that volume.

If you’re satisfied with the results, run Disk First Aid again to confirm that all is well. At
this point, if Disk First Aid reports that the drive is OK, and if you have sufficient space
on your backup device, consider making a backup of the repaired drive (keeping your
original backup). This way, if the disk still has some lingering problems, you can use
your original backup as a fallback option.

If Disk First Aid and your disk utility can’t repair the file system, it has a serious prob-
lem and you should not attempt to install Mac OS X on it yet. Your best course of
action at this point is to reformat the disk using the steps in the next chapter of this
document. Otherwise, skip to the following chapter.

Keep in mind that when there is a serious problem with your file system, some of the
files in your backup may be corrupted. Restoring a corrupted file to your reformatted
drive won’t cause the drive to become corrupted, but the damaged file will likely fail
to open properly.
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Formatting Your Hard Disk

You will rarely need to reformat a hard drive before installing Mac OS X. However, if
you encountered serious problems while verifying the file system, or if the drive is not
currently in the proper format, you will need to reformat it.

What is the proper format? If you plan to install Mac OS X on the same disk (or disk
partition) as Mac OS 9, the disk must be in Mac OS Extended format (previously
known as HFS+). In both Mac OS 9 and Mac OS X, you can check the format of a disk
by selecting it in the Finder and then choosing Get Info from the File menu. If the disk
is not already formatted as Mac OS Extended, you’ll have to erase and reformat it
before installing Mac OS X.

Mac OS X can be installed in as little as 2GB of disk space. However, this will leave 
very little space for your applications and work files. For design and print production,
a minimum of 8GB is recommended.

Formatting a volume on your hard disk permanently erases all the files contained in it,
so make sure you have a current backup of any important files before you reformat.

Using Disk Utility
The Mac OS X installer CD contains an application called Disk Utility that allows you 
to format and partition your disk. This section will guide you through the formatting
and partitioning process. Choose the appropriate section below depending on
whether the disk is already partitioned and whether you want to end up with one 
or more volumes.

Erase a disk and create a single volume
This task completely erases all files and volumes from the disk, whether it currently
contains one or multiple volumes. A single large volume is created.

1. Make sure you have a backup copy of your important files.

2. Start up your computer from the Mac OS X Disc 1 CD. (To start the computer from a
CD, press the “c” key after you hear the startup chime, and hold it until the Apple logo
appears on the screen.)

3. From the File menu, choose Open Disk Utility.

4. Select the Erase tab.

5. Select the disk you wish to erase from the list of disks on the left side of the Disk
Utility window. (In the list, volumes have names next to their icons; disks have sizes.)

6. In the Volume Format pop-up menu, choose Mac OS Extended.

7. In the Name field, enter a name for the volume that will be created.
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Formatting terms

Format (Erase). When you format or erase 
a disk, important data structures on the disk
are rewritten, effectively deleting all of the
files and folders it previously contained.

Partition. To divide a single hard disk into
two or more virtual drives called volumes.
Each volume appears as a separate disk icon
in the Finder. (A partition is the same as a
volume.)

Volume. An entire unpartitioned hard drive,
or a partitioned section of one.

To partition or not to partition?
For most Mac OS X users, a single partition
(or volume) is recommended. When you 
get a new Mac, it contains a single volume.
However, if you are accustomed to working
with multiple volumes in Mac OS 9, you can
continue to do so in Mac OS X.

Using a single volume on your drive will 
simplify file organization. If you decide to
partition the drive, you need a good strategy.
Think about how you work and where you’re
going to store files. Then you have to decide
on an appropriate size for each volume. If
you don’t get the sizes right, you may even-
tually wind up with one volume completely
filled while another is nearly empty. If this
happens, you’ll have to repartition the drive
(erasing its contents) or change the way you
organize your files.

You can install Mac OS X on a drive that con-
tains multiple volumes. Mac OS X works in
any volume as long as there is enough space.
If necessary, you can erase the contents of
some volumes and retain the data on others.



8. Click the Install Mac OS 9 Drivers checkbox to install the drivers.

9. Click the Erase button to erase the disk.

Erase a disk and create multiple volumes
This task completely erases all the files from a disk. All existing volumes are erased 
and are replaced by new volumes that you define.

1. Make sure you have a backup copy of your important files.

2. Start up the computer from the Mac OS X Disc 1 CD. (To start the computer from a 
CD, press the “c” key after you hear the startup chime, and hold it until the Apple logo
appears on the screen.)

3. From the File menu, choose Open Disk Utility.

4. Select the Partition tab.

5. Select the disk you wish to partition from the list of disks on the left side of the Disk
Utility window. (In the list, volumes have names next to their icons; disks have sizes.)

6. In the Volume Scheme pop-up menu, select the number of volumes you want 
to create.

7. Change the size of the volumes by dragging the volume divider bars or by selecting 
a partition and entering a value into its Size field.

8. Name each volume by selecting it and entering a name into its Name field.

9. Set the format of each volume to Mac OS Extended using the Format pop-up menu.
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10. Click the Install Mac OS 9 Disk Drivers checkbox to install the drivers.

11. Click Partition to partition the disk.

Erase files from a single volume
This task completely erases all the files from a single volume of a partitioned system.
The volume is not resized, and other volumes on the disk are not affected.

1. Make sure you have a backup copy of your important files.

2. Start up the computer from the Mac OS X Disc 1 CD. (To start the computer from a 
CD, press the “c” key after you hear the startup chime, and hold it until the Apple logo
appears on the screen.)

3. From the File menu, choose Open Disk Utility.

4. Select the Erase tab.

5. Select the volume you wish to erase from the list of disks on the left side of the Disk
Utility window. (In the list, volumes have names next to their icons; disks have sizes.)

6. In the Volume Format pop-up menu, select Mac OS Extended.

7. In the Name field, enter a name for your volume.

8. Click Erase to erase the volume.
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Preparing the Classic
Environment

If you have software that has not yet been released in a Mac OS X version, you should
be able to run it in the Classic (Mac OS 9 compatibility) environment in Mac OS X. The
Classic environment is simply Mac OS 9 running as an application in Mac OS X. If you
already have Mac OS 9, you should update it to the latest version before installing Mac
OS X. (At the time of this writing, the current version is 9.2.2.)

If your computer is connected to the Internet, you can update your Mac OS 9 system
software by using the Software Update control panel.

1. Start up the computer in Mac OS 9.

2. From the Apple menu, choose Control Panels, then choose Software Update.

3. In the Software Update window, click the Update Now button.

4. Install the updates.

If you purchased Mac OS X v10.2 “Jaguar” and don’t have a copy of Mac OS 9, you’re
eligible to order a copy for a small shipping and handling fee. See www.apple.com/
macosx/upgrade for details.

21Guide for Creative Professionals
Migrating to Mac OS X



Updating Firmware

“Firmware” is software that resides permanently on your Mac to control various hardware
components inside the computer. You may need to update your computer’s firmware
before installing Mac OS X.

Look in the Firmware Updates folder located in the Utilities folder on your Mac OS X
installer CD to see whether an update is included for your particular Mac. If your Mac
does need a firmware update, read the About Firmware Update file for your computer.
This file contains information about what the update does and gives installation 
instructions.

You can also go to docs.info.apple.com/article.html?artnum=86117 for a list of Macintosh
models that require a firmware update before installing Mac OS X.

You may also want to search www.info.apple.com/support/downloads.html. For example,
to find out whether you need a firmware update for your PowerBook G3 computer, use
the search feature on that page to look for “PowerBook G3 firmware update.”
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Installing Mac OS X

Installing Mac OS X is easy. After it’s installed, it will guide you through setting up the
system to your preferences. Here’s all you need to do to get started:

1. Quit any open applications.

2. Insert the Mac OS X Disc 1 CD into your computer.

3. In the window that appears, double-click the Install Mac OS X icon.

4. When asked to restart your computer, click the Restart button.

5. When your computer restarts, follow the Mac OS X Installer instructions. They will
guide you through the simple steps needed to install the software.

When you install Mac OS X, none of your existing files are overwritten. By default,
Mac OS X is installed in addition to Mac OS 9, not in place of it.

Installer Options
The Installer application will guide you through the installation process.

You can quit the installation anytime before you press the final Install or Upgrade 
button in the Installing step. To stop the installation, select Quit from the Installer
menu. You are presented with a confirmation dialog. Press Restart to stop the 
installation process.

To eject the CD, press and hold the mouse button right after you hear the startup
chime. Your disc ejects and your Mac restarts from your existing system.
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Step 1: Introduction
Click the Continue button when you’re ready to proceed.

Step 2: Read Me
The Read Me file contains important system compatibility information. Read through 
it to make sure that your system is compatible with the version of Mac OS X that
you’re installing.

Step 3: License
Read the license agreement and click Continue. A dialog appears that contains the
buttons Agree and Disagree. If you click Agree, the installation continues. If you click
Disagree, the license agreement reappears. You must either agree to the license to
continue the installation, or use the Installer menu to quit the Installer application.

Step 4: Select Destination
Click the icon of the volume on which you want to install Mac OS X. A green arrow
appears on the icon to indicate that you can install Mac OS X on the volume.

Once you have selected a volume, the Options button at the bottom of the window
becomes active. Click it to view various installation options. Since you have already
prepared your disk using instructions in this guide, the default Install Mac OS X choice
is what you want. Click OK to close the dialog, and then click Continue to proceed to
the next step.

Step 5: Installation Type
The default installation type is Easy Install, and it’s fine to use this setting. However, if
you prefer, you can reduce the size of the installation by customizing it.

To see the customized installation options, click the Customize button at the bottom
of the window. The Base System and Essential System Software must be installed; in
fact, you can’t uncheck their boxes. Leave the BSD Subsystem checked unless you are
familiar enough with UNIX to be sure that you don’t need it. The Additional Applica-
tions package includes a number of useful Apple and third-party Mac OS X programs.
You should accept the default and allow these applications to be installed.

The only choices that you should consider changing are the following:

Fonts for Additional Languages. This is off by default. Selecting this option installs
fonts for non-Asian languages. If you will be working in multiple languages, select 
this option.

Additional Asian Fonts. This is on by default. If you know that you won’t be using
Asian fonts, you can save quite a bit of disk space by skipping this.

Additional Printer Drivers. All are selected by default. Click the disclosure triangle
next to the Additional Printer Drivers checkbox to view your choices. If you know 
what printers you will be using with your system, you can skip the drivers from other
manufacturers to save disk space. If you want to be able to print to many different
types of printers without having to install additional drivers later, choose to install all
of the printer drivers. If you’re installing on a PowerBook or iBook, installing all of the
drivers now will allow you to connect to a number of different printers when you are
on the road.

Localized Files. All are selected by default. Click the disclosure triangle next to the
Localized Files checkbox to display a list of languages that will be supported on your
system. To save disk space and reduce install time, deselect languages that you know
you won’t be using on your system.
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Easy Install. If you wish to go back to the Easy Install choices, click the Easy Install
button at the bottom of the window. Once you are satisfied with your choices, click
the Install button to install Mac OS X.

Step 6: Installing
In this step the installation takes place.

Step 7: Finishing Up
In this section, your Mac restarts.

Step 8: Additional Software
In this section, you are prompted to insert the Mac OS X Disc 2 CD. Once you do this,
the additional software you chose in Step 5 is installed. When this step is completed,
your Mac restarts and you will set up your Mac with Setup Assistant.

Setup Assistant
After Mac OS X is installed, your Mac restarts and opens the Setup Assistant applica-
tion. The first screen you will see is a welcome screen. During the setup process you
will be asked a number of questions that will allow Setup Assistant to configure your
computer and register your software.

Network setup
You will configure your network setup during this process, so make sure you have the
network settings you recorded from Mac OS 9 available. In some cases (such as when
your computer is connected to a DHCP server), Setup Assistant can detect your net-
work and configure it for you, so you may not be asked any networking questions at
all. If you are unsure of your network settings, you can skip over the network setup
steps and configure it later.

Setting up a user account
You will also create your user account during the setup process. Be sure to make a
note of your user name and password for future reference. You can change your user
account information at any time after the setup is complete.

Software Update
If your Mac is connected to the Internet, Software Update will now automatically
launch and check whether there are any software updates available from Apple. It’s
recommended that you install any available updates right away, although you can 
run Software Update again and do it at a later time. In some cases, you will need 
to run Software Update more than one time in order to get all of the updates. This 
is because some updates can be installed only after previous updates are installed.
The installation is complete when Software Update reports that there are no new 
updates available.
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Migrating Your Applications

If you have added Mac OS X to your existing Mac OS 9–based computer, you probably
already have some applications that run on both operating systems. In that case, a 
simple reinstall (to ensure that all the files associated with the application are placed 
in the proper Mac OS X folders) may be all that you need. In other cases, you will need
to purchase a new version of the program. Also, most of your Mac OS 9 applications
should run fine in the Classic environment in Mac OS X.

In most cases, you will be installing applications in the Applications folder. If multiple
people use your Mac and you want an application to be available only to you, create 
a folder called Applications or another descriptive name in your home directory (the
directory that has your name on it). See the chapter “Organizing Your Files” on page 
27 for more suggestions on where to install applications in Mac OS X.

Here are the types of applications that run on Mac OS X and information on whether
you’re likely to have to reinstall them from your previous system.

• Carbon applications. Carbon applications run in Mac OS 9, Mac OS X, and the Classic
environment. If you have a Carbon application that you’ve been running in Mac OS 9,
it’s likely that you will need to reinstall it for Mac OS X. This is because many applica-
tions rely on support files being installed in various locations in the operating system’s
file structure. Before you reinstall an application, you can test it in Mac OS X to see
whether it runs properly. Or, if you prefer, contact the developer for information about
whether to reinstall the application after you upgrade from Mac OS 9 to Mac OS X.

• Cocoa applications. Cocoa applications run only in Mac OS X. Because you were run-
ning Mac OS 9 prior to this transition and thus did not have any Cocoa applications,
you will need to install the application from the installation discs.

• Classic applications. If you have some applications that run only in Mac OS 9, you
should be able to run them successfully in the Classic environment of Mac OS X. If you
have added Mac OS X to an existing Mac OS 9–based computer, you do not need to
reinstall your applications; simply double-click one to launch the Classic environment.
If you are migrating to a new Mac OS X system, you will want to install your Mac OS 9
applications on the new computer. You should install them in the “Applications (Mac
OS 9)” folder.

Application preferences and data files
Whether you can move your existing preferences from Mac OS 9 to Mac OS X depends
on the application. Contact the developer of your application for information.

Data files created using an application in Mac OS 9 can almost always be opened with
a Mac OS X version of the same application.
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Organizing Your Files

Mac OS X is a multiuser operating system, so it can keep the documents and prefer-
ences of a computer’s users separated and properly arranged. This means that two 
people can use the same computer and have a different user experience. It also means
that the directory structure of Mac OS X is different from that of Mac OS 9.

In addition, you will encounter a number of seemingly duplicate folders throughout
the file system. These folders each serve a different purpose and are a necessary part
of a multiuser operating system. After reading this chapter, you’ll be familiar with the
UNIX-based file structure of Mac OS X. You’ll want a basic understanding of that struc-
ture before you copy your old files onto a new Mac OS X system so that you can make
informed decisions about the best place to put each file.

User-Specific Folders
User-specific folders are those that are available to a single user of the system. Each
user account has its own set of folders. The root location of a user’s folders is his or her
home directory.

Each time a user is added to the computer, Mac OS X creates a new folder named
after that user. This folder is called a home directory, and it contains all of the user’s
files and preferences. When a user logs in to the system, Mac OS X makes his or her
home directory active and uses the information stored in it to set up the user’s desk-
top environment.

Home directories are stored in the Users folder at the root level of the startup volume.
You can quickly navigate to your home directory in a number of ways:

• In the Finder, press Shift-Command-H.
• In any Finder window, click the house icon in the toolbar.
• In the Finder, choose Home from the Go menu.

In a multiuser environment, security is important. All but two of the folders in your
home directory are locked to other users of the system. As long as you use the proper
folders, all of the files you save will be accessible only to you. The one exception to this
rule is that a system administrator can unlock your folders and view their contents.

Home directory folders
You will notice that your home directory contains a number of folders that have 
special icons. These folders are used by many applications as default locations for 
saving files. Each folder’s name describes the types of files that it is designed to store.
You can actually store any type of file in any of the folders; their names are just a 
convenient way to help you keep your files organized.
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Folders and directories
Macintosh users are accustomed to the term
“folder” in discussions of the computer’s file
system. Because Mac OS X is based on UNIX,
you may also see the term “directory,” which
is customary among UNIX users. The terms
are interchangeable, and this document 
uses both.



Here are some of the folders you’ll see in your home directory when you first use 
Mac OS X.

• Desktop. This folder contains the contents of all of the files and folders currently
being displayed on your desktop. If you place this folder in your Dock, you can view
the contents of your desktop without closing your application windows—especially
handy if you have a lot of files on your desktop.

• Documents. This is a place to store files such as letters, financial documents, spread-
sheets, and so on. However, because some applications may also store files here, to
avoid their clutter, you may wish instead to create a folder called My Documents
inside your home directory.

• Library. This special folder holds your application preferences, resources, sounds, and
other files needed by applications and the system to create your individual desktop
experience. For example, your personal browser bookmarks are kept here. Each user 
of the system will share the same browser application, but the bookmarks that the
browser uses will be taken from the logged-in user’s Library folder.

• Movies. Use this folder to store your movie files. If you need to find a movie, you 
simply navigate to your home directory and open your Movies folder.

• Music. Use this folder to store your music files. If you need to find a song, you simply
navigate to your home directory and open your Music folder.

• Pictures. Use this folder to store your digital pictures. This is the default location that
iPhoto uses to store your photos.

• Public. This is a special folder that is also available to other users of the system. Files
placed in this folder are available to everyone, so don’t store sensitive information 
in this location.

• Drop Box. Inside the Public folder is a folder called Drop Box. This folder has a unique
property in that other users can put files into it, but they can’t open it. As the owner of
this folder, you can open it to retrieve its contents. This is a way for other users to give
you files that are intended only for you to view.

• Sites. This folder is open to all users and is used if you want to host a web page on
your system. Don’t store sensitive information in this folder.

In addition to the preceding folders, which are created when you install Mac OS X,
you can also create your own folders in your home directory. For example, you may
want to create an Applications folder to hold applications that only you use. (Note 
that some applications look for a folder with this name in which to store files, so if 
you want to avoid that, you may want to call your folder My Applications.)

The access privileges for user-created folders depend on the folder’s location. Any 
folder or file that you put in the root level of your home directory is available to all
users. If you want a folder or file to be available only to you, put it in one of the folders
that is locked to other users.

You may notice that at the same level as the individual users’ folders is a folder called
Shared. This folder is used by applications to store preferences needed by all users.
You can also use the Shared folder for files that you want to share with all users of the
system. Unlike your Public folder, which by default makes files available on a read-only
basis, files in the Shared folder have full read/write access. You can decide which folder
to use for each shared file depending on what kind of access you want it to have.
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System-Level Folders
At the root level of the startup disk are a number of folders used by Mac OS X to 
configure the operating system itself. Among the most important folders are:

• Applications. This folder is the default location for storing applications that need 
to be available to all users. It therefore has read and write access for users. Most 
application installer programs use this folder as the default location for storing the
application.

You can quickly navigate to the Applications folder in a number of ways:
– In the Finder, press Shift-Command-A.
– In any Finder window, click the Applications icon in the toolbar.
– In the Finder, choose Applications from the Go menu.

• System. This folder contains important files that are critical to the operation of the
system. Regular users are restricted to read-only access to the files in this folder.
Making changes to this folder is not recommended.

• Library. This folder—which is in the System folder—is used to store system 
configuration files and application preferences that affect all users of the system.
Generally, these files are not as critical to the operation of the system as those 
in the System folder. Nonetheless, they are important system files, so user access to
this folder is read only. You must have administrator privileges to make changes in 
this folder.

• Users. This folder contains the home directories of all users of the system.

Note that if you have installed the Classic environment, the startup disk also has a
folder called System Folder. This folder contains the Mac OS 9 operating system and 
all Mac OS 9 system-level files, such as fonts and control panels.

Why are there so many Library folders?
You might be wondering why there are so many Library folders. And if you’ve looked
inside the various Library folders, you’ve noticed that each one has similar contents.
There are a number of Library folders because Mac OS X is a multiuser operating sys-
tem. The libraries and their contents are hierarchical, with the settings of the lower-
level folders being able to override or add to the settings in the higher-level folders.

For example, each Library folder contains a Fonts folder. Which applications and users
can use specific fonts depends on which /Library/Fonts folder the fonts are put in.
(See “Installing Fonts” for details.) The same is true of Preferences, Printers, Keyboard
Layouts, and other folders that reside in every Library folder.

Filenames and Extensions
Mac OS X supports filenames up to 255 characters in length, but not all applications
do. Therefore, current versions of some applications may have trouble saving files with
names longer than 31 characters.

Long filenames can be particularly troublesome for linked images or other graphics
because the internal reference to the linked file kept by a page layout application,
for example, is a truncated version of the filename. If the document is reopened on
another computer, the link may be broken because no file with the truncated name
can be found.

For the time being, many problems can be avoided by keeping filenames to 31 
characters or less, including the extension (if there is one).
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Why are there two Desktop folders?
When you start up Mac OS X for the first 
time on a Mac that has previously been 
started up in Mac OS 9, you may find two
Desktop folders. One is in your home direc-
tory and is simply called “Desktop.” The other
one, at the computer (root) level, is called
“Desktop (Mac OS 9).”

If you’re like many users, you prefer to keep 
certain files and folders on your desktop.
Because Mac OS 9 is essentially a single-
user system, it typically has only one desktop
area. However, Mac OS X allows each user to
have an individual desktop. That’s why you’ll
see a Desktop folder in each user’s home
directory. But when Mac OS X starts up and
finds items that were on the Mac OS 9 desk-
top (where the concept of multiple users is
unknown), it can’t assign those items to a
specific user, so it puts them at the root level
above the user directories.

To see the files that were originally on your
Mac OS 9 desktop, simply open the folder
named “Desktop (Mac OS 9).” If there were 
no files on the Mac OS 9 desktop when you
started up the computer in Mac OS X, that
folder will not be present.

Note that if you installed Mac OS X on a 
separate partition from Mac OS 9, you will
find your Mac OS 9 desktop files in a folder
named “Desktop Folder” in the root level of
the partition in which Mac OS 9 is installed.



A file extension consists of a dot (.) followed by several letters that identify the type 
of file. Examples are “.doc” and “.mov”. Currently, Mac OS X and most Mac OS X appli-
cations relate documents and applications by using the traditional Macintosh Creator
Code resource and/or the filename extension.

In the future, however, applications may no longer support the Creator Code resource,
and instead may rely exclusively on the filename extension. To prepare for this, it’s a
good idea to begin using filename extensions on all of your new documents. Most
applications support extensions automatically, or let you toggle extensions on and off.

By default, filename extensions are not shown in Finder windows. You should turn on
extension visibility by choosing Preferences from the Finder menu and clicking the
“Always show file extensions” checkbox. If you have created your own file extensions in
the past, check them against currently used ones to avoid confusion. There’s a search-
able database of file extensions at www.filext.com.
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Moving Your Files 
to a New Mac

If you are transitioning to Mac OS X by moving to another Mac, you now need to
transfer your files to your new computer. The examples in this chapter will guide 
you through the process of moving files from a computer running Mac OS 9 to one
running Mac OS X. If you have added Mac OS X to your existing Mac OS 9 system,
you don’t need to read this chapter.

There are a number of ways to transfer your files from one Mac to another. The 
following methods are discussed in this chapter:

• Copy files over a network (or a network cable)
• Use FireWire Target Disk Mode
• Use an external FireWire hard disk drive
• Copy files to a CD-R or DVD-R

Method 1: Copy Files over a Network
One of the easiest ways to connect two Macintosh computers together is to network
them. You can either connect them to an existing Ethernet network, or simply run an
Ethernet cable from one to the other. Once you have the systems networked, follow
the steps below to copy your files.

To perform this task, you need a standard RJ-45 Cat5 Ethernet cable. All recent
Macintosh models automatically configure themselves to work with either a crossover
cable or a standard Ethernet cable. Older models require a crossover cable. To find 
out the cabling requirements for your Mac, please see docs.info.apple.com/
article.html?artnum=42717.

File transfer speeds vary from one network to another, but if your computers 
have 100-Mbps or faster Ethernet ports, and they are connected to a 100-Mbps or
faster network (or they are simply connected together with a single Ethernet cable),
your transfer times should be reasonably fast. Mac OS X supports the built-in Gigabit
Ethernet on all current Power Mac systems and most PowerBook models.
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Step 1: In Mac OS 9—Turn on AppleTalk

1. From the Apple menu, choose Control Panels > AppleTalk.

2. In the AppleTalk control panel, select Ethernet from the Connect Via pop-up menu.

3. Quit the control panel.

Step 2: In Mac OS 9—Turn on File Sharing

1. From the Apple menu, choose Control Panels > File Sharing.

2. Select the Start/Stop tab.

3. Enter an owner name in the Owner Name text field if one isn’t already present. Make 
a note of the owner name—you’ll need to enter it in order to connect to your Mac
across the network.

4. If you don’t know your current password, enter a new password in the Owner
Password text field. Make a note of the password; you’ll need to enter it in order to
connect to your Mac across the network.

5. Enter a name for your computer if one isn’t already present. This is the name that
identifies the computer when you browse the network for it.

6. In the “File Sharing off” section, click the Start button.

7. Quit the control panel.
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Step 3: In Mac OS X—Turn on AppleTalk

1. From the Apple menu, select System Preferences.

2. Click the Network pane to edit its settings.

3. From the Show pop-up menu, choose Built-in Ethernet.

4. Select the AppleTalk tab.

5. Click the Make AppleTalk Active checkbox.

6. In the Configure pop-up menu, choose Automatically.

7. Click the Apply Now button to apply your settings.

8. Quit System Preferences.

Once you have completed these tasks, you are ready to copy your files. You will 
connect to your Mac OS 9 computer from your Mac OS X computer.

Step 4: In Mac OS X—Copy your files

1. In the Finder, choose Connect to Server from the Go menu.

2. Your Mac OS 9 computer will appear in the leftmost column of the Go window. This
may take a few seconds.

3. Double-click your Mac OS 9 computer’s name. The Name and Password dialog appears.

4. In the Name and Password dialog, enter the owner name and password you defined 
in Step 2 into the appropriate text fields, then click Connect. If you entered the name
and password correctly, you will see a dialog that says, “Select the volumes you wish 
to mount.” If you didn’t enter the proper information, you will see a Login Failed dialog
and you’ll need to reenter the name and password.

5. In the Select Volumes dialog, highlight all the volumes in the list and click OK.

6. If everything went properly, one icon for each volume you selected appears on 
your desktop.

7. You can now navigate around your Mac OS 9 disk and copy any of its files to your 
Mac OS X computer.
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Method 2: Copy Files Using FireWire Target Disk Mode
FireWire Target Disk Mode allows a Macintosh computer with a FireWire port to be
used as an external hard disk on another FireWire-equipped computer. The computer
that’s acting as a hard disk is called the target. The computer that’s accessing the 
target disk is called the host. Once a target computer is started up as a FireWire hard
disk and is connected to the host computer, you can copy files to or from it.

Compatible systems
To use FireWire Target Disk Mode, both your Mac OS 9 computer and your Mac OS X
computer must have FireWire ports. In addition, the target computer must have:

• FireWire version 2.3.3 or later
• Mac OS 8.6 or later

All Mac systems with built-in FireWire ports are able to enter FireWire Target Disk
Mode and to start up from FireWire, with some exceptions. The following models 
cannot be used for FireWire Target Disk Mode:

• Power Mac G3 (Blue & White)
• Power Mac G4 with 450MHz or slower processor and PCI graphics

The models below can be used for FireWire Target Disk Mode only if they have
received the Boot ROM upgrade and are now able to start up in either Mac OS 9 
or Mac OS X:

• Power Mac G4 with 500MHz or slower processor and AGP graphics
• Early FireWire-equipped iMac models (prior to July 2000)

You can test any particular Mac by restarting it and holding down the “T” key. If you
see a FireWire logo, Target Disk Mode is supported. If instead you see the normal
Finder, Target Disk Mode is not supported (or the Boot ROM is out of date).

To check for updates on which models support FireWire Target Disk Mode, please 
see docs.info.apple.com/article.html?artnum=58583.

Using FireWire Target Disk Mode
You will use your Mac OS 9 computer as the target. This allows you to browse your old
files from your new Mac OS X system. You will then copy files from your old computer
to your new one.

To use FireWire Target Disk Mode, follow these steps:

1. Make sure that the target computer is turned off. If you are using a PowerBook or
iBook as the target computer, you should also connect its power adapter to an AC
source. The host computer does not need to be turned off.

2. Connect the two computers with the appropriate FireWire cable. (Generally this will 
be a 6-pin to 6-pin cable, although if your new computer has FireWire 800, you can
also use a 6-pin to 9-pin cable. Be aware, however, that the transfer speed will be that
of FireWire 400, the speed of FireWire on your Mac OS 9 system.)

3. Start up the target computer. Immediately press and hold down the T key until the
FireWire icon appears. The hard disk of the target computer should appear on the
desktop (unless your Mac OS X system preferences are set not to display connected
volumes, in which case you’ll need to navigate to the target drive from a Finder 
window).

4. When you are finished copying files, drag the target computer’s hard disk icon to the
Trash, or select Eject from the File menu.

5. Turn off the target computer.

6. Unplug the FireWire cable.
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Method 3: Copy Files Using an External Storage Device
If you are unable to use FireWire Target Disk Mode and you can’t connect your Mac
computers together with a network cable, you can use an external storage device to
transfer your files.

External storage devices come in many shapes and sizes. There are hard disk drives,
solid-state devices that can fit on your keychain, and removable media devices (such
as Iomega’s Zip drive). All of these devices commonly connect to your Mac using
either a FireWire or USB connection. You will usually get faster throughput from a
FireWire connection than a USB connection, so if you have a choice of connection
types, use FireWire.

If your device has a small storage capacity, you may have to make multiple trips
between your two computers. This is not a problem as long as you don’t have a file
that is larger than the capacity of your external device.

Unless your external device can plug directly into the computer’s FireWire or USB 
port (typically the case with keychain units), you will need a cable. See the sidebar 
for information about FireWire and USB cables.

Although it’s unlikely, you may need special software that allows your external device
to work with your Mac systems. Check with the maker of the device to see whether
you need to do anything special to make it work on your computers.

Once you have confirmed that your external storage device works with both of your
Mac systems, you can start transferring files. Follow these simple steps:

1. Connect your external storage device to your Mac OS 9 computer.

2. Copy some files from your Mac to the storage device.

3. Disconnect the device.

4. Connect the device to your Mac OS X computer.

5. Copy the files from the device to your Mac OS X computer.

6. Remove the copied files from the device.

7. Remove the device from your Mac OS X computer and repeat steps 1 through 6 
until all of your files have been transferred.

Method 4: Transfer Files via CD or DVD
If you are unable to use any of the preceding methods and you have a CD or DVD
recorder on your Mac OS 9 computer, you can use it to make one or more discs con-
taining your data files. Once you’ve copied all of your files onto a disc, simply insert it
into your new Mac and copy the files onto that computer’s hard drive.

When you are creating the CD or DVD, be sure to format it as a data disc using Mac
OS Extended/HFS+ format (or a hybrid Mac/Windows format).
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FireWire and USB cables
FireWire connectors come in three varieties:
9-pin, 6-pin, and 4-pin. All current Macintosh
computers have FireWire 400 ports that use
6-pin connectors. Some Macintosh models
also have FireWire 800 ports, which use 9-
pin connectors. You will need to determine
which kind of connector your external stor-
age device uses. Various types of FireWire
cables are available to go between two 
similar or dissimilar connectors.

USB connectors come in two varieties: Type 
A and Type B. Computers use Type A con-
nectors, and according to the USB specifica-
tions, external devices should use Type B 
connectors, so all you should need is a 
standard USB A-B cable. However, some
external devices use Type A connectors,
so be sure to check before buying a cable.



Mac OS X Basics

Welcome to Mac OS X! Users familiar with Mac OS 9 will feel right at home here. You’ll
find favorite old features as well as exciting new ones. Here’s a summary of how Mac
OS X operates, including some ways in which it differs from Mac OS 9.

You can see a handy guide to Mac OS X at www.apple.com/macosx/learning.

Memory Management and Allocation
In Mac OS X, you no longer need to allocate memory to each application. The operat-
ing system handles all memory management and virtual memory, which is always in
use. You will still need to allocate memory for any Classic applications you run, just as
you did in Mac OS 9.

System Preferences
You can now manage a wide range of system customization options in a single pro-
gram called System Preferences. It’s located in the Applications folder on your Mac OS
X disk, or you can easily access it at any time from the Apple menu. Third-party utilities
and drivers can add their own preference panes to System Preferences, providing one
central location for managing your preferences.
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The Dock
Located by default at the bottom of your screen, the Dock gives you instant access to
the programs, files, and tools you use most. All open applications are represented by
Dock icons. To put your own often-used items within easy reach, simply drag them to
the Dock. Similarly, you can remove an item by dragging it out of the Dock. Items you
may find useful to add to the Dock include your Desktop folder, the Print Center appli-
cation, and any application or document folders you use frequently.

As you add items, the Dock expands until it reaches the edges of the screen—at which
point the icons in the Dock shrink to accommodate additional items. You can also
change the size of the Dock at any time from System Preferences. Or you can change
the size by dragging the line that divides the Dock.

To make reduced-size icons more easily recognizable, Mac OS X includes a magnifica-
tion option. When you pass your cursor over the icons, they magnify to the level you
have set in Dock preferences. You can also make the Dock hide itself when you’re not
using it. Minimized windows (ones that you’re not currently using but want to keep
handy for easy access) display a miniaturized view of the full window. You can maximize
the windows again with a single click.

The Dock gives you quick access to useful functions. You can use its contextual pop-
up menus to quit any application or to navigate to any open window of a selected
application. If you’ve stored a folder in the Dock, clicking its icon and holding the
mouse button allows you to view the subfolders within it. Clicking and holding the
mouse button on the Trash icon will allow you to empty the Trash, if there is anything
in it.

If you prefer, you can store the Dock at the right or left side of the screen instead of at
the bottom. Dock preferences can be changed by selecting Dock from the Apple menu.

Toolbars
Every Finder window can display a toolbar that contains useful navigation controls. It
also contains a search window that is used to find files or folders—the search starts at
the currently selected folder and includes its subfolders.

You can customize the toolbar by adding frequently used applications, folders, or docu-
ments to it. You add items to the toolbar by dragging them into it; you remove them by
simply dragging them out. You can also add a number of navigation controls and icons
to the toolbar in the Finder by selecting View > Customize Toolbar.
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You can turn the display of the toolbar on and off by clicking the button in the upper
right corner of any Finder window or by selecting Hide Toolbar/Show Toolbar from the
View menu (Command-B).

Finder Views
Every Finder window can display its contents in three views—icon, list, and column.
While the icon and list views will be familiar to you from Mac OS 9, the column view 
is new to Mac OS X.

The column view lets you see your files in context. The rightmost column can even
give you a preview of many common file types. For example, you can watch a
QuickTime movie, hear a song, or view a still image—all without launching an appli-
cation or opening the file. You can change the width of the columns by clicking and
dragging at the bottom of the column dividers. This is the same view that you see in
the Mac OS X Open and Save dialogs. When you use column view for the first time, it
may be easiest to start by moving the slider bar to the far left and then navigating to
the right to find the folder you want. This method will quickly get you oriented to this
powerful new navigation system.
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Finder Commands and Shortcuts
Some of the keyboard shortcuts in the Mac OS X Finder are different from those in
Mac OS 9. Here’s a reference chart for some of the most-used ones.

Shortcut Mac OS 9 function Mac OS X function

Command-H Search Internet Hide Finder

Option-Command-H — Hide others

Command-N New folder New Finder window

Shift-Command-N — New folder

Command-P Print window —

Command-L — Make alias

Command-M Make alias Minimize window

Command-C Copy (item names only) Copy (items or names)

Command-V Paste (in item names only) Paste (items or names)

Command-Y Put away (desktop item) —

Some shortcuts have been added in Mac OS X to support new Finder features.

Shortcut Mac OS X function

Command-1 Icon view

Command-2 List view

Command-3 Column view

Command-B Show/Hide toolbar

Command-[ Go back

Command-] Go forward

Shift-Command-C Go to Computer folder

Shift-Command-H Go to Home folder

Shift-Command-I Open iDisk folder

Shift-Command-A Go to Applications folder

Shift-Command-F Go to Favorites folder

Shift-Command-G Go to folder (enter name)

Command-K Connect to server

You’ll find a handy list of Mac OS X keyboard shortcuts at docs.info.apple.com/
article.html?artnum=75459.

Application Menus
Each Mac OS X application has an additional menu bar item—the application menu.
It has the name of the application, and it appears between the Apple and File menus.
The application menu contains several items related to the application itself, including
the About box, program preferences, relevant Mac OS X services, options to hide or
show windows from this and other applications, a Quit command, and other options
determined by the application’s developer.
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Open and Save Dialogs
Mac OS X Open and Save dialogs are somewhat different from those in Mac OS 9. For
example, like any other Mac OS X window, you can make a dialog bigger or smaller by
dragging the size control in the lower right corner.

The Save dialog may open in a collapsed view that shows only a pop-up menu con-
taining your defined Favorites and a place to enter the name of the file to be saved.

If you want to save the file in one of your Favorites locations, simply select the location
in the pop-up menu and enter your desired filename. However, if you want to navi-
gate to some other folder location on your system or network to save the file, you can
click the downward-pointing arrow next to the pop-up menu to expand the window
and display the column view browser, allowing you to navigate to the desired folder.
Once you have selected a folder, you can add it to your Favorites by clicking the Add
to Favorites button.

When you use a Mac OS X Open or Save dialog for the first time, it may be easiest to
start by moving the slider bar to the far left and then navigating to the right to find
the folder you want. This method will quickly get you oriented to this powerful new
navigation system.
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Connecting to a Server
Mac OS X allows you to connect to every major file server protocol on every major
platform in use today. This includes Apple, UNIX, Linux, Novell NetWare, and Windows
computers and servers. In Mac OS X, connecting to other computers and servers is no
longer done through the Chooser as it was in Mac OS 9.

1. From the Go menu in the Finder, select Connect to Server.

2. Look for the name of the server you want to connect to in the list.

• If you see network areas or Windows workgroup names, select one to see the servers
it includes.

• If you see Local in the list, select it to see the names of shared Mac computers on your
local network or subnetwork.

• If you are connecting to a Mac computer with Personal File Sharing turned on, look 
for the computer name specified in Sharing preferences on that computer.

• If you don’t see the computer, type its URL in the Address text box. The URL consists 
of the protocol (afp://) and the DNS name (for example, “myserver.company.com”) or 
IP address (for example, “192.168.2.42”).

3. When you find the shared computer or file server you want to connect to in the list,
select it, then click Connect.

4. A dialog appears for you to enter the authentication information required to access
the server. The items you need to enter depend on the type of computer you are 
connecting to and how it’s set up.

5. Once you have logged in, the server volume appears on your desktop as well as in 
the Computer view of every Finder window.
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Force-Quitting an Application
Because of the protected memory in Mac OS X, an application that misbehaves will
not harm the overall system. However, you may need to “force-quit” that application.
As in Mac OS 9, you can force-quit an application by pressing the key combination
Command-Option-Escape. Unlike Mac OS 9, which force-quits the frontmost applica-
tion, Mac OS X opens a window that contains a list of currently running applications
and allows you to choose one or more to force-quit. Note that this list includes the
Finder. Because the Mac OS X Finder is an application much like any other, it can be
quit and relaunched from this window without affecting other running applications.

Linking a Filename Extension to an Application
You may have more than one application that can open a particular type of file. For
example, Apple’s Preview application opens files with the extension .tif. If you have
installed Adobe Photoshop, you may wish to have it open these files instead.

Using the .tif file example, do the following:

1. In the Finder, select a file that has the .tif filename extension.

2. Choose File > Get Info from the menu bar.

3. In the Get Info window, click the “Open with” disclosure triangle.

4. In the pop-up menu, select the application that you want this file to be opened 
with—in this example, Adobe Photoshop 7.

5. If you want all files with this extension to be opened in Photoshop, click the Change 
All button.

6. When the confirmation dialog appears, click Continue.

7. Close the Get Info window.

The Classic Environment
You can start the Classic environment from the Classic pane in System Preferences,
or by double-clicking any Classic (Mac OS 9) application. You can also stop, restart, or
force-quit Classic from the Classic preference pane.
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Carbon applications can be run as either Classic or Mac OS X applications. You can
choose to run such an application in Classic by clicking the “Open in the Classic 
environment” checkbox in the application’s Get Info window in the Finder. Generally
speaking, you will get better performance and reliability if you run Carbon applica-
tions in Mac OS X rather than in Classic.

Using the Classic system preference
You can control the behavior of the Classic environment using the Classic system pref-
erence. The three panes in this preference let you set up and monitor the behavior of
the Classic environment.

Use the Start/Stop pane to:

• Set which Mac OS 9 System Folder to use for Classic (in case you have multiple 
Mac OS 9 systems installed on your Mac).

• Start, stop, restart, or force-quit Classic.

• Have Classic start automatically when you log in. This is useful if you often run Classic
applications.

• Have Mac OS X warn you before Classic is started. If you double-click a Classic appli-
cation to launch it, you will be given the chance to stop the process before Classic 
is started.

Use the Advanced pane to adjust the advanced settings and to troubleshoot the
Classic environment. From this pane you can start Classic in special ways, similar to
Mac OS 9 itself.

The advanced settings include:

• Use preferences from home folder. This function is useful if there are multiple users
of the system. With this option checked, when users start the Classic environment the
first time, a dialog lets them copy existing preferences from the Mac OS 9 System
Folder to the Classic folder in their home Library folder.

• Put Classic to sleep when it is inactive. If the Classic environment is running but 
you don’t have any Mac OS 9 applications open, this option allows Classic to go to
sleep to reduce its use of your computer. Use this setting to specify how long Classic
waits to go to sleep after you quit the last Classic application. If Classic is in sleep
mode, opening a Mac OS 9 application may take a little longer.

• Rebuild Desktop. This command rebuilds the Classic desktop file of icons and docu-
ment-application bindings for the selected startup volume.

The advanced settings that aid in troubleshooting are in the pop-up menu next to 
the Restart Classic button. These options are:

• Turn Off Extensions. Because extensions can sometimes cause unexpected behavior
in Mac OS 9, it’s useful to be able to launch Mac OS 9 without extensions when trou-
bleshooting problems.

• Open Extensions Manager. This option allows you to activate or deactivate specific
extensions, rather than simply turning them all off. If you have Conflict Catcher
installed in Classic, the system will restart in it instead of in Extensions Manager.

• Use Key Combination. This option allows you to define keystrokes that will start or
restart the Classic environment.

The final pane, Memory/Versions, allows you to view the memory usage of applica-
tions running in the Classic environment. This is similar to the information you would
find in the “About this Computer” dialog under the Apple menu in Mac OS 9.
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Printing

Mac OS X uses a powerful new printing architecture. In Mac OS X, all printers are
always available from any application. You can switch from printer to printer instantly
to meet the needs of each job, without having to open and reconfigure the Chooser.
The Print Center application, which replaces the Chooser, provides fast access to many
different printing-related commands and settings. Support for multithreaded printing
allows you to send a job to one printer and immediately print again to another type
of printer; the system automatically starts sending the second job to the correct
device. Mac OS X also offers additional ways to connect your printer, each with its 
own benefits. For example, even printers that aren’t network enabled can be made
available to all users on the network at no additional cost.

Supported Print Protocols
The following printing protocols and connections are supported in Mac OS X, listed 
in order of typical preference:

• Rendezvous. If your printer supports Rendezvous, it is the quickest and easiest way
to connect it to your Mac. Rendezvous will not print across subnets.

• AppleTalk. AppleTalk printers are easy to set up and support printing of binary data as
well as back-channel (status) communication. In the past, AppleTalk has been viewed
as a “chatty” protocol—one in which devices use network resources all the time by
continuously announcing their presence. Changes in how Mac OS X implements
AppleTalk mean that traffic on a network of Mac OS X v10.2 computers is very low 
and should not pose network traffic problems.

• LPR. LPR is a UNIX-standard printing protocol that supports printing across subnets,
but does not support back-channel communication or the printing of binary data.

• USB. The three protocols listed above are for network printers, but many printers can
be connected directly to your computer via the USB port. With a USB printer set up,
you can turn on Printer Sharing in the Sharing pane of System Preferences to allow
other computers on your network to use your directly attached printer.

Supported Printers
For a list of external devices, including printers, that are compatible with Mac OS X, see
www.apple.com/macosx/upgrade/devices.html.

Because printing in Mac OS X as of v10.2 “Jaguar” is based on the Common UNIX
Printing System (CUPS), you may be able to use a printer even if the manufacturer has
not provided Mac OS X support. Check the Mac OS X section of the GIMP-Print web-
site at gimp-print.sourceforge.net/MacOSX.php3 for drivers compatible with CUPS and
your printer. Currently over 500 printer models are supported through GIMP-Print.
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Installing GIMP-Print requires the installation of ESP Ghostscript, an open source
PostScript interpreter that’s also available at the GIMP-Print site. Once Ghostscript is
installed, you can print to any supported printer as though it were a PostScript device.

For non-PostScript printers, custom paper sizes can be defined and shared among
users by editing and distributing the file <user home directory>/Library/Preferences/
com.apple.print.custompapers.plist.

ColorSync Profiles
In Mac OS X, ColorSync is fully integrated into the operating system. In fact, Mac OS X
v10.2 is the only operating system that fully supports the ICC version 4 standard for
managing color. This integration makes it easy for developers to build color manage-
ment features into their applications, resulting in greater productivity and higher-
quality results.

A new Color Management Module (CMM) in Mac OS X increases the speed and preci-
sion of color transformations. It takes advantage of the power of the Velocity Engine
to dramatically speed up the most common color calculations, and the Apple CMM
uses multiprocessing whenever possible for further performance enhancements. As 
a result, color matching in Mac OS X v10.2 is nearly twice as fast as in any previous 
version of the Mac OS.

If you have been using ColorSync in Mac OS 9, you can easily move your profiles to
your Mac OS X system and immediately get the color results you are used to.

Profile locations
If you have custom ICC profiles that you have used in Mac OS 9, copy them from 
your ColorSync Profiles folder (in the System Folder) to an appropriate location in 
Mac OS X, depending on which users you want to have access to them. Here are 
the available locations:

• For all users of the same Mac system:
/Library/ColorSync/Profiles/

• For each individual user of the Mac system:
/Users/username/Library/ColorSync/Profiles/ 
(also referred to as ~/Library/ColorSync/Profiles/)

• For access over a managed network:
/Network/Library/ColorSync/Profiles/

Note that the operating system installs profiles in a read-only location,
/System/Library/ColorSync/Profiles/. It is not advisable to put your own profiles in 
this directory.

Installing PPDs
Some popular design and print applications need to have PostScript Printer
Description (PPD) files in a special PPD folder before they can print device-
independent PostScript jobs. If the PPD for your PostScript printer is not installed 
by Mac OS X, you can add it by placing it in /System/Library/Printers/PPDs/
Contents/Resources/en.lproj/.

(This directory path assumes that English is the language of your system. For other
languages, place the PPD in the language-specific folder in the Resources directory.)
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You will not be able to copy the PPD into this directory until you change the direc-
tory’s permissions. Assuming that you are logged in with an administrator account,
you can temporarily change the permissions to allow the file(s) to be copied:

1. Select the /System/Library/Printers/PPDs/Contents/Resources/en.lproj/ directory in a
Finder window.

2. From the File menu, select Get Info.

3. Click the disclosure triangle next to Ownership & Permissions.

4. Note that the directory is “owned” by the system (root) account.

5. Click the small padlock icon to the right of the permissions.

6. Authenticate yourself with your user name and password.

7. Change the Owner pop-up menu to your own account.

8. Copy the PPD(s) to the folder.

9. Change the Owner pop-up menu back to system.

10. Click the padlock once again to prevent further changes.

Print Center
Adding, managing, and choosing printers in Mac OS X is done with the Print Center
application rather than with the Chooser as in Mac OS 9. Print Center is located in the
Utilities folder in the Applications folder on your system volume.

Setting a default printer
After you launch Print Center, if the Printer List window is not open, choose Printers >
Show Printer List. If you have more than one printer defined on your computer, you
can select any one and make it the default printer by doing one of the following:

• Click the Make Default button in the Printer List window toolbar.

• From the Printers menu, choose Make Default.

The default printer is the one that is automatically selected in the Print dialog of 
all Mac OS X applications. However, you can easily select any of your defined printers
from the Print dialog whenever you want to send a job to the printer. You don’t need 
to designate a printer from the system-level Chooser prior to printing as you did in
Mac OS 9.

You can access Print Center from any standard Print dialog by selecting Edit Printer
List from the dialog’s Printer pop-up menu.
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Configuring your printers
Mac OS X recognizes and configure many USB printers as soon as you connect them
to your computer and turn them on. You can use Print Center to select and configure
network printers. Mac OS X ships with drivers for today’s most popular USB inkjet
printers and also includes printer description files (PPDs) for more than 200 PostScript
printers.

To add a new printer using Print Center:

1. Click the Add button.

2. In the dialog, select the printer connection type. For all printer connections except IP
Printing, Print Center searches and displays a list of available printers.

3. Choose the printer you want to add.

4. Select the printer model and click Add.

Managing your print jobs with Print Center
Print Center is also used to manage your print jobs. You can stop and start each 
printer queue, and you can hold, resume, and delete print jobs. Just by glancing at 
the Print Center icon in the Dock, you can tell how many print jobs are printing, or 
see when there is an error with a print job. You can click and hold the Print Center
icon to get information about what jobs are printing or waiting in queue.

Queuing jobs for later printing
If you’re not connected to your printer when you’re ready to print a job, you can 
have Print Center hold your jobs so they can be printed at a later time. To do that,
follow these steps:

1. Open Print Center.

2 Choose Stop Queue from the Queue menu.

3. Leave Print Center and return to your application.

4. Use the Print command in the application just as though you were printing right now.

5. When you are once again connected to your printer, choose Start Queue from the
Queue menu.
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Drag-and-drop printing
Print Center makes it easy to print PDF files, text files, or the contents of a folder.
Simply drag and drop PDF files or text files to the Print Center icon, and they are 
printed to your default printer. If you drop a folder on the icon, a list of the folder’s
contents is printed. If Print Center cannot print a file directly, it opens the application
that created it and you are presented with a standard print dialog.

Print Center security
In multiuser lab or production environments, you may want to consider securing 
the Print Center application to limit the changes that users can make to the printing
environment. For information on how to do this, see www.macosxlabs.org:16080/
documentation/printing/printing_secure_printcenter/intro.html.

Printing as PDF or PostScript
Mac OS X allows you to create a PDF or PostScript file of a document from an applica-
tion that does not have its own PostScript or PDF export capabilities. That means you
can now make PDF files from any Mac OS X application—a great way to exchange
documents with clients and colleagues.

Mac OS X v10.2 “Jaguar” adds a handy “Save as PDF” button to the Print dialog. Simply
click it instead of the Print button, and your document is converted to a PDF file that’s
readable by Adobe Acrobat Reader, Mac OS X Preview, and other PDF viewers.

You can save a document as a PostScript file by following these steps:

1. Choose Print from your application’s File menu.

2. In the Print dialog, look for the pop-up menu that says Copies & Pages. Choose Output
Options from that menu.

3. Click the Save as File checkbox.

4. Choose PostScript from the Format pop-up menu. If the PostScript option is dimmed
(not available), you have not set up a PostScript printer in Print Center.

5. Click the Save button. Your document is saved as a PostScript file.
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Working with Fonts

Mac OS X supports tens of thousands of fonts in many different formats, including
Mac PostScript Type 1, Mac and Windows TrueType, Multiple Master, OpenType, and
Mac OS X System (dfonts) fonts.

In Mac OS X, fonts can be installed in a number of different places in the file system.
This is due in part to the fact that Mac OS X is a multiuser operating system. A font
can be installed in a location that is private to a single user, one that can be shared 
by all users of a computer, or even one that’s shared by users across a network. (If the
Mac OS 9 Classic environment has been installed, it has its own fonts folder. Certain
publishing applications also have private font locations.)

Any Mac OS X system can be used as a central font depository from which multiple
systems can open fonts over the network. You won’t need to spend your valuable time
managing individual font files or making large suitcases on each computer.

For a comprehensive overview of fonts and font technology in Mac OS X, see the 
document “Using and Managing Fonts in Mac OS X” at www.apple.com/creative/fonts.

Where to Install Fonts
If you use the same set of fonts all the time, consider installing all of them perma-
nently in one of the Mac OS X font folders.

A Mac OS X system has the following built-in font locations. In organizing your fonts,
note that Mac OS X recognizes fonts contained in subfolders inside these folders.

• Computer Fonts folder (/Library/Fonts/). This is the equivalent of the traditional Fonts
folder in Mac OS 9. Fonts in this folder are available to everyone who uses the Mac.
However, only a user with administrator access can change the contents of the folder.
Fonts in this folder are not available to Classic applications.

• User Fonts folder (<user home directory>/Library/Fonts/). Only the individual user
can use these fonts. These fonts are also not available to the Classic environment.

• Classic Fonts folder (<Classic System Folder>/Fonts/). If you’re running both Classic
and Mac OS X applications and you don’t use a font manager, this is the place you
should put all your fonts. Both Classic and native Mac OS X applications can use 
these fonts.

• System Fonts folder (/System/Library/Fonts/). This folder contains all fonts used by
Mac OS X for menus, dialogs, and icons. It should not be used for your own fonts.
You can see the fonts here, but you can’t easily modify this folder. (The document
mentioned above describes how to do so.) Do not remove the font LucidaGrande 
from this folder, or the computer will not start up.
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Fonts Panel
Mac OS X has an advanced feature for selecting and organizing fonts called the 
Fonts panel. The Fonts panel lets you choose fonts and colors in a consistent manner.
Divided into collections, families, typefaces and size, the Fonts panel lets you create
your own font collections or add fonts to a Favorites menu. You can set the font size
from standard sizes, or use a slider to select the size. The Show Preview command in
the Extras pop-up menu lets you see the selected font. You can change the preview
text, then select different fonts and sizes to see how it looks from font to font.

Once you’ve set your defaults, you can shrink the Fonts panel to show only pop-up
menus and leave it conveniently in a corner of your screen. The Mac OS 9 fonts in your
Classic System Folder are also displayed in the Fonts panel.

Character Palette
In addition to the Fonts panel, Mac OS X has a feature called the Character Palette.
You use the Character Palette to enter special characters such as dingbats and 
symbols. You can also use it to enter Japanese and Traditional and Simplified 
Chinese characters.

To use the Character Palette, you must turn it on in the International system prefer-
ence. Do the following:

1. From the Apple menu, choose System Preferences.

2. Select the International pane by clicking its icon.

3. Select the Input Menu tab.

4. Click the Character Palette checkbox.

To open the palette, choose Show Character Palette from the Input menu (the one
with the Character Palette symbol or the flag).

To enter a character, choose the items you want to see from the View pop-up menu.
Select the category of characters in the left column and double-click the character or
symbol you want to enter in the right column.

Click the triangle at the bottom of the palette to see more options, such as the font
you want to use.
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Keynote, Apple’s presentation software that 
is increasingly popular among graphic arts
professionals, makes full use of the advanced
font and graphics capabilities in Mac OS X,
including the Fonts panel. Keynote is more
than just a presentation tool. You can use it
to build digital design portfolios, animated
storyboards, and dynamic photographic
shows. The high-quality graphics support 
in Keynote allows creative professionals 
to import assets from QuickTime, Adobe
Photoshop, Adobe Illustrator, Macromedia
Flash, and Apple’s iLife applications.



Font Managers
If the fonts you use change from day to day or project to project, using a font man-
ager will greatly simplify your workflow. Popular Mac OS X font managers include:

• Font Agent Pro (www.insidersoftware.com)
• Font Reserve (www.fontreserve.com)
• Suitcase (www.extensis.com)

If you decide to use a font manager in Mac OS X, and you also have one installed in
Mac OS 9, be sure to disable the font manager in Mac OS 9. If you were using ATM
Deluxe as your font manager in Mac OS 9 and you have to disable it, you will need to
install ATM Light to get smooth type in Classic applications.

Other Mac OS X Font Features
Mac OS X uses a new type of font named a dfont. It’s a TrueType font with its informa-
tion in the data fork rather than in the resource fork as in older Macintosh TrueType
fonts. dfonts work only on Mac OS X systems and only in Mac OS X (not Classic) 
applications.

Many dfonts, such as Zapfino, contain extended character sets that designers may
wish to use. You can use the Character Palette to examine the dfonts and determine
whether you want to use any of them. If you don’t, you should remove all nonessential
dfonts and replace them with PostScript Type 1 or OpenType versions, either directly
in the fonts folder(s) or activated by a font manager. (Do not remove the font
LucidaGrande, or the computer will not start up.) Remember that if you decide to use
dfonts and you’ll be printing the final piece on a different system, it will have to be a
Mac OS X system that has the same fonts.

Font rasterization is now built into the operating system, so Adobe Type Manager is
not needed for that purpose. You will need to install ATM Light in the Mac OS 9
System Folder in order to get smooth type in Classic applications.
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Beginning with Mac OS X 10.2, support for single-instance Multiple Master fonts 
is built into the operating system. However, Adobe InDesign 2.x, Photoshop 7.x,
Illustrator 10.x, and Acrobat 6.x do not currently recognize these instances if they 
are installed in one of the standard Mac OS X font locations. These applications 
support Multiple Master fonts only if they are placed in the Adobe-specific directories,
/Library/Application Support/Adobe/Fonts/ or <user home directory>/Library/
Application Support/Adobe/Fonts/.

Other font tools that may be of use include:

• Apple Font Tools (developer.apple.com/fonts/OSXTools.html)
• Typeset (font viewer; www.vizspring.com)
• Fontage (font viewer; www.arcaneware.com)
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Sharing Files

Mac OS X makes it easy to share files with users of Mac and other systems in a 
number of different ways.

Public Folder
You can make your Public folder accessible to other users by turning on Personal 
File Sharing in the Sharing pane in System Preferences. By default, your Public folder
and the folders within it are the only ones that can be shared. To share additional 
folders, you can use a third-party tool such as SharePoints (www.hornware.com/
sharepoints). Or you can edit the NetInfo database from the Mac OS X command 
line, which is accessible from the built-in Terminal application.

Important: Sharing folders other than your Public folder may represent a security risk,
so be sure you know what you’re doing before you change their access privileges.

In addition to Personal File Sharing, which uses the Apple File Protocol, files in your
Public folder can be shared with Windows computers via Samba, and with a wide
range of platforms through FTP.

If you have a .Mac account, you can put files in the Public folder of your iDisk, where
they can be viewed or copied by anyone who knows your .Mac member name and
can access iDisk Public folders. For wider access, use the HomePage application in 
.Mac to set up a file-sharing page that lets everyone on the Internet copy items from
your Public folder, regardless of whether they’re .Mac members or what type of 
computer they use.

Drop Box
To give a copy of a file to someone who uses the same computer or a different com-
puter that’s networked to yours, you can copy it to the person’s Drop Box folder.

To give a file to someone who uses your computer, open the person’s Public folder (in
his or her home folder in the Users folder on your hard disk) and copy (Option-drag)
the file to the Drop Box folder.

To give a file to someone who uses another computer on your network, choose
“Connect to Server” from the Go menu and connect to the user’s computer. (Guest
logins work fine for this; you don’t need to be a registered user of that computer.)
Then drag the file to the Drop Box folder. If you can’t find someone’s Public folder 
on the network, make sure the person has file sharing turned on.
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In some instances, a file’s permissions—the read/write privileges assigned to it—can 
be affected by its location at editing time. If another user places a file in your Drop 
Box, you should move it to another folder in your home directory (such as Documents)
before making any changes to it. After you have edited the file, save the document
before putting it in the other person’s Drop Box. Permission issues are typically applica-
tion specific and are not a concern in most cases.

Shared Folder
At the same level as the individual users’ folders is a folder called Shared. This folder is
often used by applications to store preferences needed by all users, but it can also be 
a convenient place to store data files that all users of the computer need access to.

iChat
The iChat application allows connected users to transfer files. First, establish a chat with
the person you want to send the file to. Choose Buddies > Send File, then select the file
you want to send and press Return. The recipient will see a link to the file in his or her
chat window. Clicking the link downloads the file to the directory specified for web
downloads in the Internet pane in System Preferences.
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Appendix A:
Mac OS X Quick Reference

This section describes some important aspects of how Mac OS X organizes files.

Mac OS 9 vs. Mac OS X Organization
Mac OS X stores items in slightly different locations than Mac OS 9. Here’s a listing of
some of the major changes.

Mac OS 9 element Mac OS X location 

Chooser printer options Print Center in Utilities folder in Applications folder 

Chooser AppleShare options Connect to Server in Finder Go menu 

Fonts folder in System Folder Fonts folder in Library folder 

Sounds Sounds folder in Library folder in home folder 

Utilities folder Applications (Mac OS 9) folder 

Apple Extras folder Applications (Mac OS 9) folder 

Internet folder Applications (Mac OS 9) folder 

Mac OS 9 applications Applications (Mac OS 9) folder 

Desktop items Desktop (Mac OS 9) folder 

Documents folder Documents folder for each user 

Sleep, Restart, and Shut Down Apple menu 

Special menu No longer necessary 

Finder preferences Finder application menu 

Application preferences Application menu in the application 

Control panels System Preferences 

File Sharing Sharing pane in System Preferences 

Software Update control panel Software Update pane in System Preferences 

SimpleText TextEdit 

TCP/IP control panel Network pane in System Preferences 

AppleTalk control panel Network pane in System Preferences 

AirPort control panel Network pane in System Preferences 

Modem control panel Network pane in System Preferences 

Remote Access control panel Network pane in System Preferences 

Location Manager Network pane in System Preferences 

Multiple Users control panel Accounts pane in System Preferences 

Assign Startup items Login Items in Login pane in System Preferences 

Extensions Manager No longer necessary 

Disk First Aid/Drive Setup Disk Utility in Utilities folder in Applications folder

Favorites Apple menu item Favorites item in Finder Go menu 

Find command in Finder File menu Find command in Finder File menu 
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For items in Library folders, check three places:
the hard disk Library folder, the System Library
folder, and the home Library Folder. Still can’t
find something? Use the Find command from
the File menu in the Finder.



Hard Drive Contents
The following folders, which are at the computer level, are available to all users of the
computer.

Applications—Mac OS X applications available to all users of the computer

Applications (Mac OS 9)—Mac OS 9 applications, Internet, Utilities, and Apple 
Extras folders

Documents—Folders and files stored in Documents folder with Mac OS 9

Library—Fonts, plug-ins, preferences, and other items for all users of the computer

System—Mac OS X system software files

System Folder—Mac OS 9 system software files

Users—Your home, homes of other user accounts, and the Shared folder where you
can share files with others

Desktop (Mac OS 9) folder (on desktop)—Items previously on the Mac OS 9 desktop

Home Folder Contents
Home is where you keep your own files. You can use these default folders and add
new ones to organize your files.

Desktop—Items on the Mac OS X desktop for your home

Documents—Your document files and folders

Library—Fonts, plug-ins, preferences, and other items for your use

Movies—Locations to store movies

Music—Locations to store audio files

Pictures—Locations to store image files

Public—Folder where other users can view your files; Drop Box folder for others to
leave files for you

Sites—Your web pages that can be viewed by others using Web Sharing
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Appendix B:
Supported Devices

Right out of the box, Mac OS X supports a wide range of printers, cameras, storage
media, and other external devices. Check the list at www.apple.com/macosx/
upgrade/devices.html for the latest information or visit the sites listed below for 
information on Mac OS X support for specific types of devices.

Printers
Go to www.apple.com/macosx/upgrade/printers.html.

If you have a printer that doesn’t currently have a Mac OS X driver, you can check
gimp-print.sourceforge.net/MacOSX.php3 to see whether your printer is supported by
Gimp-Print. Gimp-Print is an open source programming project that provides printer
drivers for a variety of printers, including Canon, Epson, Lexmark, and PCL printers.

Scanners
Go to www.apple.com/macosx/upgrade/scanners.html.

If your scanner is not directly supported by Mac OS X, here are some third-party
options:

• SilverFast Ai from Lasersoft Imaging (www.silverfast.com)
• VueScan from Hamrick Software (www.hamrick.com)

Digital cameras
Go to www.apple.com/macosx/upgrade/cameras.html.

Monitors and projectors
Go to www.apple.com/macosx/upgrade/monitors.html.

Storage devices
Go to www.apple.com/macosx/upgrade/storage.html.

Input devices
Go to www.apple.com/macosx/upgrade/input.html.
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Open source software projects
Open source software is simply software
whose source code is available to anyone
interested in looking at it. Open source soft-
ware is developed in a collaborative way 
with contributions from programmers all
over the world. Open source applications 
are usually of very good quality and are 
free to the end user. For more information,
visit the Open Source Initiative website at
www.opensource.org.



Appendix C: Working with 
a Multiuser System

Several people can share a Mac OS X–based system by logging in to their individual 
user accounts. Each user has a home directory, which can be located on the local com-
puter or on a network server. Each user’s system and application preferences (such as
bookmarks and desktop views) are kept in his or her home directory, providing a cus-
tomized experience for each person. Each user can control access to his or her private
files while safely sharing selected files with other users. All users sharing the computer
also have access to a common Shared folder. A designated administrator can control 
the access of other users, such as to restrict access to certain programs and functions.

Automatic login can be enabled on a Mac OS X system, but should be disabled if more
than one person uses the computer. Otherwise, anyone starting up the computer has
access to the automatically logged-in user’s documents and would have to log out and
log back in to access his or her own account and files.

Permissions
Because Mac OS X is a multiuser system, different users have different “permissions,” or
privileges, to access files and folders on an item-by-item basis.

You can examine the permissions for an item in the Finder by selecting it and choosing
Get Info from the File menu. In the Info window, click the disclosure triangle next to
Ownership & Permissions to view the settings for the item. If you are the owner of the
item or an administrator, you may also be able to change the item’s permissions.

Administration and System Security
The first user account created on your computer is designated an “administrator.”
Administrators are users with special privileges: They can create new user accounts,
install software, and change general computer settings.

If you forget the administrator password, you can reset it using the Mac OS X CD. Start 
up from the Mac OS X Disc 1 CD and choose Reset Password from the Installer menu.
Because any user with the Mac OS X CD can gain unrestricted access to the computer,
you should keep the CD in a safe place.

If you need a higher level of security, you can use Open Firmware Password Protection,
which prevents anyone (including you) from accessing the computer without the Open
Firmware password. For information, see docs.info.apple.com/article.html?artnum=106482.

You can require a password to access the computer after the screen saver appears in case
users log in and leave the computer unattended. Use the Screen Saver pane in System
Preferences to turn this feature on.
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Appendix D:
System Maintenance

Because Mac OS X is based on the UNIX operating system, system maintenance is
somewhat different than with Mac OS 9. A number of standard UNIX utilities—many
of which now have easy-to-use Macintosh graphical interfaces—and Macintosh-
specific utilities are included with Mac OS X.

Here are a couple of tips for keeping Mac OS X running well:

• Use Software Update or visit the Apple website regularly for security, operating 
system, and Apple application updates. You can set Software Update to check for
updates daily, weekly, or monthly.

• Install the latest version of Mac OS X on an external FireWire drive so that you can
quickly start up a troublesome computer for diagnosis and repair.

Fixing File System Errors
Many file system errors are minor and not even noticeable, but occasionally they 
may prevent the computer from starting up in a normal state. This could occur after
an improper shutdown, forced restart, or power interruption.

If you see any of the following symptoms, you should use a disk repair utility:

• System starts up partially and displays a command-line prompt.

• System starts up partially but does not display a command-line prompt.

If either situation occurs, first try a feature introduced in Mac OS X v10.2 “Jaguar” called
Safe Boot. It may allow you to restart successfully using a reduced version of system
software. During this restart, an automatic disk check and repair is performed that 
may resolve your issue. If it does, you do not need to take any further action.

Follow these steps to see whether Safe Boot will resolve your issue:

1. Restart the computer (using the Power button or Reset/Interrupt button if necessary).

2. Immediately after the system startup sound, press and hold the Shift key until Safe
Boot appears on the screen. (Note that there may be a considerable delay before this
happens, particularly on larger startup volumes, because the disk check and repair
take place before Safe Boot appears.)

3. After the system is fully started up, restart again normally.

If the restart is successful, you do not need to do any more troubleshooting.
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Disk Utility
If the Safe Boot disk repair was not successful, try verifying and repairing the internal
disk using Disk Utility from a Mac OS X startup CD.

1. Insert your Mac OS X CD-ROM disc or Restore DVD disc, then restart the computer
while holding down the “c” key.

2. Once the system has started up, choose Disk Utility from the Installer menu.
(Important: Do not click Continue in the first screen of the Installer. If you do, you must
restart from the disc to access Disk Utility.)

3. Click the First Aid tab.

4. Click the disclosure triangle to the left of the hard drive icon to display the names of
your hard disk volumes and partitions.

5. Select your Mac OS X volume, if it isn’t already highlighted.

6. Click Repair. Disk Utility checks the disk.

7. Start up the computer again, this time from your normal startup disk.

If the restart is successful, you do not need to do any more troubleshooting.

fsck utility
If you still have not been successful, or if you do not have access to a Mac OS X CD 
or DVD, you can use the built-in fsck (file system check) utility, which may be able to
verify and repair your startup disk.

The fsck utility is run from the command line. This means that you must type a text
command rather than using the mouse pointer to open an application.

To run fsck:

1. Restart the computer.

2. Immediately after the startup sound, press and hold both the Command (Apple) and
“s” keys on your keyboard. The computer displays a series of text messages. As soon as
the first message appears, you can release the keys. When the computer has started
up, it displays “#” as a command-line prompt (as opposed to the normal “%” prompt in
Terminal). The computer is now in single-user mode.

3. At the prompt, type “/sbin/fsck -y” (without the quotation marks) and press Return.
(Be sure to include the initial “/” in the command.)

The fsck utility goes through five “phases” and then returns information about the
disk’s utilization and fragmentation. Once the check is finished, if no issue is found,
you should see the following message:

** The volume <name of volume> appears to be OK.

If fsck alters, repairs, or fixes anything, it displays the message:

***** FILE SYSTEM WAS MODIFIED *****

If that message appears, repeat the /sbin/fsck -y command until it no longer appears.
It is not unusual for your computer to require several “passes” of fsck, because first-
pass repairs may uncover additional errors.

4. When fsck reports that no problems were found, type “reboot” (without the quotation
marks) and press Return. The computer should start up normally and allow you to 
log in.
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Repairing Permissions
Sometimes the privileges or permissions of certain items in the file system can
become modified in such a way that an application may crash or not function 
properly. Disk Utility provides a mechanism to repair the permissions of operating 
system files and directories.

1. Open the Disk Utility application (in /Applications/Utilities/).

2. Click the First Aid tab.

3. Click the disclosure triangle to the left of the hard drive icon to display the names of
your hard disk volumes and partitions.

4. Select your Mac OS X volume, if it isn’t already highlighted.

5. Because this is your system volume, and you are running Disk Utility from that volume,
the normal Repair Disk and Verify Disk options are disabled, but you can select Verify
Disk Permissions or Repair Disk Permissions.

6. Click the Repair Disk Permissions button. Disk Utility repairs the permissions on the
volume.

To ensure that permissions are properly set, you may want to repair permissions after
you install a new application or a software update.

Third-Party Disk Utilities
You may want to have other Macintosh disk utilities on hand. The following are some
of the most popular disk optimization and repair products from other vendors:

• Alsoft DiskWarrior
www.alsoft.com

• Micromat TechTool Pro and Drive 10
www.micromat.com

• Norton Utilities for Macintosh
www.symantec.com

You may also want an application that makes it easy to create your own startup disks
for emergencies. Products for that purpose include:

• Carbon Copy Cloner
www.bombich.com/software/ccc.html

• CopyCatX
www.subrosasoft.com
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For More Information 
For more information about Mac OS X,
visit www.apple.com/macosx.


